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INTRODUCTION

INTRODUCTION

Nervous, excited, frustrated, giddy, exhausted—maybe one of those words
captures how you feel right now as you look at this Absolute Beginner’s
Guide. Learning how to use a new piece of software or getting up to speed
on a new version is not always fun. On the other hand, you likely enjoy
learning new things when you see new possibilities and feel the benefits.
Visio may be a mystery to you now, and you may feel some trepidation, but
rest assured this book was designed to quickly get you comfortable with
this amazing program.
Visio is all about visualizing ideas and information. You can create amazing
diagrams to show how processes work and how things interact. You
can create floor plans and layouts with relative ease. Visio is used more
often than you probably realize, from web content and org charts to
advertising and business presentations. It has been said that a picture is
worth a thousand words, and Visio allows you to speak volumes, which is
why it has become an integral tool for businesses that put a premium on
communication.
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Visio has been around since 1992 and has gone through some big transformations
to keep pace with the demands of technology. If you have used it in the past,
you’ll find some new features worth getting excited about. If you have never used
it, prepare to be amazed. You will love how easy it is to create diagrams using
templates and to preview changes using themes. Using Shape Data, you will find
new ways to display information that are limited only by your imagination.
Despite the complexity and overwhelming potential that Visio presents, it is all
built on basic concepts and tools that you will quickly grasp. If you have an artistic
side, you will enjoy how satisfying Visio makes it to visualize and present information and data.
The Visio 2013 Absolute Beginner’s Guide will assist you as you explore this application and consider ways to change and improve your ability to communicate
ideas and concepts to others. We’ll encourage you to poke around, try different
things, and we will alert you to some best practices and tips. Above all, enjoy
learning about Visio.

What This Book Covers
Visio is a communication tool used everywhere by people of all backgrounds and
all types of organizations. Because of this, we have tried to keep to the basics and
provide essential tips and suggestions to help you save time and give you the
knowledge needed to make you a power user, no matter how you use Visio.
Although you may feel like an absolute beginner, we will quickly have you creating
diagrams and working with Visio’s tools, and you will feel your confidence grow.
You can follow along using different templates, and where more advanced
concepts are considered, you will see the steps you can follow. At times we may
only point out that there are more complex options or that more can be learned
than we have space to develop.
Because Visio 2013 comes in three versions, we principally consider information
that is practical to any user of Visio. We will try to point out anything that may be
unique to specific versions along the way. A few chapters have content aimed at
users with Professional or Pro for Office 365 versions, and we warn you when this
is the case.
With this book you will be able to do the following:
• Create your own flowcharts, org charts, and network diagrams using a variety
of shapes and connectors.
• Create and manage customized shapes and arrange your own stencils.
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• Organize and arrange your diagrams using a variety of tools, such as
containers, callouts, and layers.
• Utilize SmartShape features and shape data to create more powerful
communication tools.
• Print your diagrams efficiently using an array of settings and tools to control
what prints and how it will appear.
• Export Visio content for use in other applications in different formats.
• Share your Visio drawings with others through a variety of tools, including
email, SkyDrive, and SharePoint.

How This Book Is Organized
This book is arranged in three parts, which are broken down into chapters:
Part I, “Visio 2013 Basics,” helps you get familiar with the tabbed interface used
in Visio 2013. You will become familiar with the components of a basic diagram,
including Page Backgrounds and Themes. You will create drawings using
Templates and understand the ins and outs of Shapes and Stencils.
Part II, “Customizing,” will deepen your awareness of additional features to
be found in Shapes and Connectors. You will get to know tools that help you
work better with content in your drawings using Containers, Layers, and Text.
Editing, Duplicating and Formatting options are considered and you will dive into
SmartShapes and Shape Data. You will learn all about Printing in this section.
Part III, “Advanced,” introduces you to the many ways you can share and export
your diagrams into other formats. You will see how to use special Touchscreen
menus and learn about other unique situations here. How to collaborate with
other Visio users and where to find more Visio content and information will be
considered. You will learn about more complex ways to use and work with Data,
including data that is maintained outside of Visio. Finally, you will look at unique
features and get some tips for working with specific templates and diagram types.

Conventions Used in This Book
Most terms specific to Visio will be explained as we go along in the book.
However, there are a few terms and standards that we had in mind while
preparing this book that we should explain at the outset.
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Working with Visio Tools and Menus
When the book describes labels or titles that you can see on the screen while
working with Visio, they will be capitalized. Instructions to press a specific key or
keyboard combination will also be capitalized, like this:
1. Select the Design tab.
2. In the Page Setup section, click the Page Setup button or press Shift+F5.
3. Review settings on the Page Size tab and click OK.
Because of touchscreen interfaces, we generally use the term “select” rather than
“click” to describe the process of activating a button or menu item, so feel free to
click, tap, or press the indicated item to carry out the action. When there is a need
to activate a button to continue to another step, “click” tends to sound better and
has been used for that reason.

Using Screen Illustrations
The screen illustrations used throughout the book as figures are a valuable
reference tool. Generally, illustrations will show you the step being discussed in
the text. Some illustrations are cropped to focus attention on details, whereas
others show the whole Visio window to help you get familiar with how things are
laid out. Look around and notice tabs and features that are not being discussed,
just to get a feel for where things are located. Occasionally, we may include
callouts or combine multiple elements in a single illustration so that you can
compare menus or layouts.

Web Addresses
You may see web addresses referred to in the book. These are offered as points
of reference in examples, or they may point to additional information or resources.
They will appear in this format:
http://www.microsoft.com
Throughout this book you will see the words “drawing” and “diagram” used
almost as synonyms. Both are words used in the Visio interface, and they tend
to be interchangeable. Technically, a diagram refers to a more conceptual
drawing, whereas a drawing conveys the idea of a more finished product with
measurements and details. In practice, some types of templates tend to be
considered as diagrams, whereas others are more often referred to as drawings.
Don’t think you need to read into the way these terms are used in this book.
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Special Elements to Watch For
As with all books in this series, Visio 2013 Absolute Beginner’s Guide includes
special items that provide additional information that will add to your
understanding:

TIP Tips indicate a useful time-saving step, shortcut, or a way
for you to easily get better results.

NOTE

Notes provide additional background information or
related material about the task or topic being considered. It’s not
information you absolutely need to know, but it may provide you
with a clearer understanding of the topic.

CAUTION Cautions alert you to potential undesirable results
and point out items or choices that could cause problems if misunderstood or accidently used.
Although you could read this book from beginning to end, you will likely find it
practical to jump around, and we have included references to subjects that are
considered more in depth in other places in the book. Feel free to go back and
forth as you get familiar with specific tasks and topics.

WrightBook 1.indb 5

7/1/13 11:48 AM

WrightBook 1.indb 6

7/1/13 11:48 AM

IN THIS CHAPTER
• How will templates save me time?
• What make templates different?
• How can Visio save my diagram?
• How will using multiple windows help me develop
mad multitasking skills?

3

WORKING WITH BASIC
DIAGRAMS
Visio is all about making great visuals, and you will spend a lot of time
focused on the drawings themselves. This chapter provides a good point
to step back and see all the other features of Visio that will help you later
as you work on those drawings. Consider how choosing the right canvas
and frame can make a great work of art look awesome.
Templates, file formats, pages, backgrounds, and your work area are all
fundamental to having the right canvas and frame for the drawings you
create. We look at templates and the drawing window in detail in this
chapter. Chapter 4, “Taking Control of Your Diagrams,” considers how
pages and backgrounds further accentuate your work.
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Making Diagrams
I enjoy building cabinets from scratch. Despite how satisfying the final product can
be, finding the right wood and materials can be time consuming, and the project
can also take much longer than expected (sorry, dear). For that reason I have on
occasion been quite happy with purchasing a cabinet from IKEA and spending a
fraction of the time assembling a very nice-looking cabinet.
Templates serve a similar purpose. No one questions your imagination and artistic
abilities, and you certainly can create drawings from scratch in Visio if that is your
preference. You will quickly appreciate the many advantages of using templates
when you see how they save you time.

What Is a Template?
We’ve thrown this term around quite bit, but what is a template? Templates refer
to the overall framework that determines appearance, purpose, and even the tools
that are used to make your diagram. They include the sets of shapes and stencils
present in the Shape panel; the size and scale of the page you work on; the paper
size for printing; settings related to font, color, and many others that dictate the
default behavior of shapes and connectors in your diagram. You might even see
additional Ribbon tools unique to that template, as in the case of an Organization
Chart template.

Find the Right Template
We used a Basic Flowchart template in Chapter 1, “Getting to Know Visio 2013,”
and you no doubt were tempted to check out some of the other templates in the
Template Gallery (see Figure 3.1). Visio 2013 Standard includes many predefined
templates, and Professional has even more. The included templates have a very
modern look with shapes and content that have been selected to reflect the times
we live in.
When you choose to start a new Visio diagram, you are presented with featured
templates by default. You can refine the choices by using categories, which
presents eight groups of templates as shown in Figure 3.2 (Business, Engineering,
Flowchart, General, Maps and Floor Plans, Network, Schedule, and Software and
Database).
In addition you can search for online templates. We’ll come back to this feature
later in this chapter.
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FIGURE 3.1
Right away, you may recognize a few interesting-looking choices in the Template Gallery.

FIGURE 3.2
There are eight categories of templates.

WrightBook 1.indb 43

7/1/13 11:48 AM

44

VISIO 2013 ABSOLUTE BEGINNER’S GUIDE

Take a look at the purpose of these categories and what sets them apart from
each other.
• Business templates include Organization Charts, Marketing, and Charts and
Graphs. You find tools for analyzing processes such as Cause and Effect or
Fault Tree. Many people have learned to use mind mapping or brainstorming
diagrams.
• Engineering offers several templates, including Basic Electrical and Part and
Assembly Drawing (see Figure 3.3).

FIGURE 3.3
Looking at a category of templates provides an array of choices, as these engineering
templates illustrate.

• Flowchart templates include the Basic Flowchart, BPMN Diagram, and
Workflow Diagrams.
• General includes Basic Diagram and Block Diagrams. This is a good area to
start with if the diagram only needs very basic shapes and stencils.
• Maps and Floor Plans include many types of templates. You can create 2D
or 3D map graphics for advertising, floor plans and layouts, detailed HVAC,
ceiling grids, and site plans.
• Network templates include ways to represent the physical network, rack
diagrams, and more conceptual diagrams to visualize Active Directory or LDAP
Directories.

WrightBook 1.indb 44

7/1/13 11:48 AM

CHAPTER 3 WORKING WITH BASIC DIAGRAMS

45

• Schedule templates provide tools for calendars, Gantt charts, and timelines.
• Software and Database has many templates, such as Data Flow, Database
Notation, Program Structure, and Web Site Map.
When you select a specific template , a small window appears (see Figure 3.4)
with a few details related to the purpose of the template and its origin. You can
choose to use Metric or U.S. units of measurement and then select Create. You
can also scroll to the left or right, clicking arrows to browse other templates.

FIGURE 3.4
Selecting a template provides you with an explanation of how you would use this template.

HOW TO VIEW TEMPLATES
Think of a template as an advanced starting point for your diagram. At times it is
enough to have a flowchart template and a blank page. However, if you find that
you often are creating similar content or variations on the same diagram, you might
consider setting up and saving your own template.
In a personalized template you can determine the shapes and stencils available. You
can also include personalized elements, such as company logos. To further customize
the starting point of your diagrams, you can even include a page with prepopulated
content.
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➜

To learn how to create your own templates in Visio, see page 252.

Working Without a Template
You can start with a blank drawing if you decide not to use the templates for the
sake of a quick diagram. You simply choose Blank Drawing from the selection of
templates featured when you first open Visio.
If you have been working in Visio and want to create a new drawing, follow these
steps:
1. Select the File tab to open the Backstage area.
2. Select New from the vertical menu to the left. You see the list of featured
templates to the right.
3. Select Blank Drawing and Create on the pop-up window that appears. Blank
drawings open with no shapes, stencils, or any other configuration settings
(see Figure 3.5). You can still work right away, selecting shapes and such from
the Home tab and the Tools menu.

FIGURE 3.5
Starting a drawing from scratch using a blank drawing.
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Clone Your Drawing
When you have invested blood, sweat, and tears into a diagram, you might not
want someone else to tamper with it. Imagine that you need to make an updated
version of an organization chart after a promotion has occurred in your company.
Maybe you want to present a couple of similar variations of a diagram in a
proposal with your customer. Rather than grabbing the original and modifying it,
it might be wiser to clone the original and modify the copy. That way, you always
have an intact original to refer back to.

Use a Recent Drawing
If you need to tweak a diagram or present variations of the same diagram, a nice
feature is the capability to easily create a copy of an existing drawing from the
Recent Drawings list in Visio.
1. Open Visio and look for the list labeled Recent off to the left.
2. Right-click a file and select Open a copy as shown in Figure 3.6. (The link at
the bottom of Recent files labeled Open Other Drawings will take you to the
Recent Drawing list discussed in the next set of steps.)
3. Notice a copy has opened with a name like Drawing1. Any alterations to this
drawing will have no effect on the original; they are completely separate.
4. To save this copy, Select File and Save As to assign a unique name and
location.
If the drawing is not listed in the Recent Drawing list, open it first so you have the
option to right-click as described.
There is another way to get to this list of recent drawings:
1. Select the File tab and then select Open.
2. As shown in Figure 3.7, helpful thumbnails display when you view the list in
this way.
3. Right-click a drawing and select Open a copy.
If you anticipate using a drawing as a base for future copies or just want to keep it
handy, you can also pin the drawing to the Recent Drawing list. As you hover your
mouse over the document in the Recent list, you see a pushpin to the right. As
shown in Figure 3.6, when you click the pin you see the document pinned to the
top of this list until you unpin it.
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FIGURE 3.6
Use Open a Copy to protect your original diagram from accidents.

FIGURE 3.7
The Recent Drawings list can also display thumbnails of your diagrams.
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Find Online Templates and Samples
As mentioned earlier, when you look at the Template Gallery you see at the
top of the page a field that allows you to search for templates from office.com.
In addition, you can search other websites and then download templates and
samples to use as a starting point for your own diagrams. Try to download from
trusted sources to avoid unexpected surprises.
➜

To find recommendations for online templates and samples, see page 311.

Save Your Diagram
Save your work. It’s easy to say, but it’s not something we always remember to
do. The mere thought might bring back memories of frustration and the Luke
Skywalkian cry of “Nooo!” that escaped your lips when an application froze or
power was lost once long ago. Visio provides a few ways to save you from those
feelings of remorse.

Save As
Save As is an important place to start soon after you create a new drawing.
When you select the Save icon in the Quick Access toolbar for the first time,
it automatically takes you to the Save As screen (see Figure 3.8). You can also
click the File tab and choose Save As on the left, or you can use Ctrl+S on the
keyboard.

FIGURE 3.8
You have a few places to choose from when saving your work.
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A new feature in Visio 2013 is the inclusion of SkyDrive as a location to save your
work. This cloud-based location is associated with your Live ID. When saved to this
SkyDrive, you can access the content from any computer with Internet access, and
you can even share files from your SkyDrive.
➜

To learn more about sharing your drawings using SkyDrive, see page 230.

THE NEW VISIO FORMAT .VSDX
Visio 2003, 2007, and 2010 all used a common .vsd format. So why change things
now? Don’t worry; this is not a ploy to force people to upgrade. Every new release of
Visio has used a proprietary .vsd format that has evolved from version to version. So it
should not surprise us that Visio 2013 has a new format. So what are the advantages
of this new format?.
The new .vsdx format uses XML content and essentially saves your file in a zipped
compression that results in much smaller file sizes. This is also consistent with other
Office applications that now use XML for their default formats, thus Word has .docx
and Excel uses .xlsx. This is great when sharing files, and it also conserves storage
space. Another perk is that XML is considered safer and more resistant to data
corruption and viruses.
With this new file format, new features can be used when working in a SharePoint
environment, such as coauthoring a diagram. For developers, .vsdx provides new
ways to work with Visio drawings, for example, programs can be designed to read
and extract data from drawings, and content in drawings can be updated to reflect a
new logo without opening the files.

When you use Save As, you can choose the file format that you want to use. As
you can see in Figure 3.9, there are many formats to choose from. The default
is named Visio Drawing; it is a new format and uses the .vsdx file extension. The
Visio 2003–2010 Drawing format choice may be practical when sharing drawings
with others who use older versions of Visio.
➜
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FIGURE 3.9
From Visio, you have many choices when choosing how to save your diagrams.

AutoSave
AutoSave does what the name implies; it automatically saves your work—if it is
configured, that is. Whereas your concern about saving a test diagram may not be
the same as saving an organization chart you have worked on for the past three
days, it is a good idea to know AutoSave is enabled and which settings are being
used (see Figure 3.10).
1. Click the Home tab to access the Backstage area.
2. Click Options at the bottom of the vertical menu on the left.
3. Select Save under Visio Options and verify your settings.
4. Click OK to save changes.
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FIGURE 3.10
You have several options when using AutoSave.

In Figure 3.10, you see the setting options for Save. Here you can change
the default format using the Save Files in This Format drop-down menu. Save
AutoRecover Information Every X Minutes allows you to enable and change the
default of 10 minutes to a shorter period of time. It is not enabled by default. To
minimize the amount of work that can be lost due to a power outage or because
a computer suddenly stopped working, some people change this to 5 minutes or
even less. If the file itself is extremely large or complex you might notice a slight
hit on performance. If that happens then increase the interval. You may prefer to
enable or disable other settings here if you desire to further fine-tune your save
experience.

TIP

If you find that the AutoSave settings do not work consistently, they may have been applied only to whichever drawing
was open at the time you made adjustments. Close all drawings
and follow the previous steps to open the Save options. Confirm
the settings you want enabled and then click OK. Now when you
open new or old drawings they should have these Save settings.
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Working with Drawing Windows
As you become more proficient with Visio, you might want more than one drawing
open at a time. Visio allows you to easily navigate among open drawings. The way
Visio handles multiple open drawings deserves a quick overview.
The Visio application is itself a window and can be moved, resized, and minimized,
like any Microsoft application. This application window includes the tabbed ribbon
interface. The main Visio application window can contain any open Visio files,
the same as modern web browsers allow for multiple tabbed web pages in one
window. You might notice what appear to be several stacked windows on the
Windows task bar; they are likely all contained in one Visio application window.
For this reason the ribbon and tabs across the top do not appear to alter when
changing from one diagram or drawing window to another.

NOTE

You may occasionally have a diagram that has a unique
tab that is needed only by that diagram, as in the case of an
office layout that uses a Plan tab. If you switch between a flowchart diagram and an office layout diagram, the Plan tab appears
or disappears, depending on the drawing window that is active.

Drawing windows refer to the work area below the ribbon interface where
you create your diagrams and drawings. Drawing windows can be minimized,
maximized, and arranged below the tabbed ribbon bar.

CAUTION If you decide to close a drawing window, make
sure you choose the correct X to do this. When your drawing
window is maximized, you see the standard application window
controls in the upper-right corner of the Visio window for Help,
Minimize, Maximize, and Close. Below that you see a second X,
which is the one to use to close the drawing window.

Task Panes
Besides the Drawing window, you have likely noticed task panes by now. These
may reveal more detailed information or provide additional options to work with
your diagram. There are four common task panes in Visio:
• Shapes
• Shape Data
• Pan and Zoom
• Size and Position
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In the Show section of the View tab you can enable or disable task panes by
clicking the Task Panes drop-down button and selecting to toggle it on or off.
In Figure 3.11 you can see four task panes listed. Shapes and Pan & Zoom are
toggled on and can be seen below in the drawing window.

FIGURE 3.11
Task panes can be turned on or off from the View tab.

The Shapes task pane we used previously and by default is turned on anytime
we open a new drawing window. It is docked on the left side of the window by
default.

TIP You can undock the Shape pane and let it float elsewhere.
Hover your pointer over the word Shapes in the header area of
the pane. When you see the cursor change, click and drag the
pane to a different location. Alternatively, you can minimize its
size by clicking the small arrow to the left of the word Shapes, as
shown in Figure 3.12. The pane shrinks to the left and reveals a
single column of shapes. Click the arrow again to expand.
You may see other task panes occasionally, and some are unique to certain
templates. They all can be moved, docked to the edge of a drawing window,
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resized, and anchored to the edges of a drawing window. Anchoring the pane
allows you to automatically hide (Auto Hide) them so they fly open only when you
hover over them.

Switching Between Windows
If you open the View tab, you notice a section labeled Window. This refers to the
drawing windows you may have open. You see four buttons here:
• New Window
• Arrange All
• Cascade
• Switch Windows
To quickly jump between windows, you may be able to use Ctrl+Tab on the
keyboard. Another option is to click Arrange All to split the available screen
space among the open drawings. This provides a way to see a portion of all open
drawings, as shown in Figure 3.12. You might use this to compare drawings side
by side.

FIGURE 3.12
You can see all open drawing windows at once using Arrange All.
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You can also select the Cascade button to see the open windows arrayed by their
Title bar (see Figure 3.13). This can be useful when you have many open drawings and you need to quickly find a specific one. When you select the drawing you
want, you can maximize the drawing window by double clicking the Title bar or by
using the traditional Windows maximize button located in the upper-right corner
of the window. This also removes the cascade effect.

FIGURE 3.13
You can use Cascade view to get a handle on what is open.

Use the New Window button to open a second view of the current drawing. You
are not making a copy; you have an additional drawing window to the same
drawing. Changes made in the first window are seen in the second, and vice
versa. This can be useful when working with a large diagram; one window can
focus on one area, and the second can position over another area. Now you can
jump between drawing windows rather than move back and forth on the diagram.
Notice how this is used in Figure 3.14; both Kitchen Remodel:1 and Kitchen
Remodel:2 are different views of the same drawing arranged side by side.
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FIGURE 3.14
The New Window feature enables you to see the same drawing from different perspectives.

Working with Full Screen Windows
Full screen or Presentation mode enables you to look at your Visio drawings like
a PowerPoint slideshow (see Figure 3.15). To enter Presentation mode, click the
projector screen on the bottom status bar just to the left of the zoom slider, or
press F5. To escape, hit F5 again, Esc, or right-click and Close.
You are not able to modify the drawing while in full screen, but you can evaluate
how the finished product will look. You can navigate through multiple pages by
right-clicking and using the Go To menu or by using your arrow keys.
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FIGURE 3.15
Full screen provides an unobstructed view of your drawing page.

THE ABSOLUTE MINIMUM
You have seen the value of templates when you start a diagram. It is a good
idea to poke around a bit the first time you use a template. Make sure you are
comfortable with the way elements in this template connect to one another. Read
the description for the template to see if it really fits the style of diagram you need
to create.
Protect your work by using copies of diagrams when appropriate and save your
work often. If you haven’t used the AutoSave feature, take the time to enable and
configure it to minimize lost work.
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It is important to understand how and when to use the Arrange All and New
Window features to help you be as efficient as possible. Visio is designed to help
you easily navigate between drawings and avoid frustration. Experiment with some
of these display features now and you will feel more confident as you quickly
create impressive diagrams that amaze your co-workers.
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Index
Numerics
1D shapes
handles, 35
resizing, 170
2D shapes, handles, 36

A
action tags. See smart tags
adding
callouts to shapes, 151-154
commands to ribbon, 25-27
comments, 323-327
connection points, 140-142
content to CAD drawings, 200
Data Graphics, 296-298
fields to headers and footers, 211
groups to stencils, 106
layers, 165
pages to drawings, 62
photos to org charts, 359-361
shape data fields, 270-274
shapes to Favorites stencil, 89
adjusting
print margins, 213
resolution of images, 192
Adjust tool group (Picture Tools), 190
aligning
shapes on Dynamic Grid, 109
text, 179
Align tool, 110-111
anchoring task panes, 55
angles, nonorthogonal, 139
applications, Office, compatibility with, 238-240
applying themes to pages, 76
arcs, eccentricity handles, 37
Arrange All command, viewing open drawing
windows, 55

WrightBook 1.indb 371

arranging
diagrams with Position tool, 111-112
shapes with Dynamic Grid tool, 108-109
aspect ratio, overriding, 170
attributes
common format attributes, modifying, 173
less common format attributes, modifying,
174-175
Auto Align & Space tool,
110-112
Auto Resize feature, 338
Auto Size tool, 69-71
Auto Space tool, 112
AutoCAD (Automated Computer-Aided Drafting)
drawings
adding content to, 200
importing, 197-199
AutoConnector feature, 124-127
Automatically Link tool, linking external data to
shapes, 293-294
AutoSave, 51-52
available stencils, browsing, 87
Avoid Page Breaks tools, 260

B
background pages
creating, 64
printing, 217-219
title
modifying, 66
background printing, 208
Backstage, 22, 31-33
printing from, 204
background printing, 208
collation, 206
paper orientation, changing, 206-208
Print Settings pane, 204-205
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BALLPOINT PEN TOOL (INK)

Ballpoint Pen tool (Ink), 327
behavior of connectors
during drag operations, 132
when shapes are deleted, 133-134
when splitting connectors, 132-133
blank pages, adding to drawings, 62
blending shapes, 348
block diagrams, blending shapes, 348
Block Diagram with Perspective template,
349-350
blogs
blogs.msdn.com/b/chhopkin, 313
the official Visio blog, 307
BPNM (Business Process Model and Notation)
flowcharts, 346
browsing available stencils, 87
building plans, dimension lines, 368-369
Business templates, 44
buttons, 23
Position button
Distribute tools, 113
Orient Shapes tools, 114-115
Presentation Mode button, 33
bvisual.net, 312

C
CAD drawings
adding content to, 200
importing, 197-199
calculations, performing on shape data field
values, 298
callouts, adding to shapes, 151-154
Cascade button, viewing open drawing
windows, 56
categories
of templates, 42-45
of themes, 72
Change Shape tool, 87-89
changing
background of text blocks, 181-183
orientation of pages, 67
paper orientation for printing, 206-208
scale of drawings, 71
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shapes with Change Shape tool, 87-89
themes, color, 74
z-order of shapes, 118
charts
organization charts, 359
creating, 363-365
creating manually, 361
photos, adding, 359-361
clip art, 193
cloning drawings, 47
Close Ink Shape tool (Ink), 327
closing
drawing windows, 53
ink shapes, 328
co-authoring tools
SharePoint, 316, 320-322
Visio drawings, checking out, 318-319
collaboration
comments
adding, 323-324
hiding, 324-326
SharePoint, 316
co-authoring, 320-322
versioning, 320
Visio drawings, checking out, 318-319
collated printing, 206
collapse ribbon, 23
color
applying to drawings, 77-78
of themes, changing, 74
print settings, changing, 223
Color and Weight tool (Ink), 327
combining drawings on a single sheet, 263
commands
adding to ribbon, 25-27
locating with Visio Options dialog box, 29
comments
adding, 323-327
hiding, 324-326
Track Markup tool, 329-331
common format attributes, modifying, 173
compatibility with Office applications, 238-240
compressing images, 192
Compress Picture tool, 192
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DECISION SHAPES

configuring print features
headers and footers, 211-213
margins, 213-214
connection points, adding, 140-142
Connection Point tool, 141
connections, creating with AutoConnector,
124-127
connectors, 124-125
behavior
during drap operations, 132
when shapes are deleted, 133-134
when splitting connectors, 132-133
connection points, adding, 140-142
control handles, 138-139
creating
with AutoConnector, 125-127
with Connector tool, 127
formatting, 135
glue
dynamic, 130-131
point-to-point, 129-130
line jumps, 136-138
properties, 129
routing styles, 136
Connector tool, 127
containers, 103, 144-147
lists, 148
modifying, 147-150
content, adding to CAD drawings, 200
context menus, 31
contextual ribbon
cross-functional flowcharts, 344-345
contextual tabs, 23
control handles, 187
1D shape handles, 35
2D shape handles, 36
of connectors, 138-139
eccentricity handles, 37
vertex handles, 36
controls available on tabs, 22
conventions used in this book, 17-18
copying
drawings, 47
shapes, 168
creating
background pages, 64
connections with AutoConnector, 124-127
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connectors with Connector tool, 127
custom themes, 75
diagrams without templates, 46
floor plans, 366-367
flowcharts, 10-11
groups, 103-106
layers, 163-165
master shapes, 94
org charts, 361-365
personalized stencils, 91-93
reports, 279, 281-285
ScreenTips, 155
templates, 252, 255
web pages from diagrams, 234
cross-functional flowcharts, 150
contextual ribbon, 344-345
swimlanes, 343
resizing, 343
Current View, printing portions of diagrams
with, 215-216
curved lines, eccentricity handles, 37
customizing
Data Graphics, 299-301
page orientation, 67
page settings, 63
ribbon, 24, 27
stencils, 91-93
templates, 45
custom templates, creating, 252, 255
custom themes, creating, 75

D
data fields
saving, 276-278
shapes, 266-274
text, displaying, 278
Data Graphics
adding, 296-298
customizing, 299-301
Position settings, changing, 300
data linked from external source,
refreshing, 295
Data tab, linking external data to shapes,
289-292
Decision shapes, 339
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DEFAULT PRINT OUTPUT VERSUS HIGH QUALITY OUTPUT

default print output versus High Quality
output, 222
deleting shapes, behavior of connectors during,
133-134
Design tab
Auto Size tool, 69-71
pages, customizing, 67
Theme Gallery, 73
Developing Microsoft Visio Solutions (Microsoft
Press), 311
diagrams
arranging with Position tool, 111-112
block diagrams
shapes, blending, 348
Block Diagram with Perspective
template, 350
callouts, 151-154
cloning, 47
connection points, adding, 140-142
connectors, 124-125
behavior during drag operations, 132
behavior when deleting shapes, 133-134
behavior when splitting connectors,
132-133
control handles, 138-139
creating with AutoConnector, 125-127
creating with Connector tool, 127
dynamic glue, 130-131
formatting, 135
line jumps, 136-138
point-to-point glue, 129-130
properties, 129
routing styles, 136
containers, 144-147
creating without template, 46
footers, 157-159
gridlines, printing, 221
grouped shapes, when to avoid, 107
headers, 157-159
legends, inserting, 299
printing portions of, 215-216
saving
with AutoSave, 51-52
with Save As, 49
ScreenTips, 155
shapes
frequently used, 84-86
Quick Shapes stencil, 83
selecting, 82
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templates, 42
Business templates, 44
categories of, 42-45
Engineering templates, 44
Flowchart templates, 44
General templates, 44
Maps and Floor Plans templates, 44
Network templates, 44
online templates, 49
personalized templates, 45
Schedule templates, 45
selecting, 45
Software and Database templates, 45
Template Gallery, 42
text boxes, 160
text fields, 160-162
validating, 346
web pages, creating, 234
dialog boxes
Field, 298
Layer Properties, 220
Page Setup, 63
Reorder Pages, 67
Ruler and Grid, 116
Visio Options
commands, locating, 29
ribbon, customizing, 25
dimension lines, 368-369
disabling task panes, 54
displaying
grid, 115-116
guides, 115-116
keyboard shortcuts, 39-40
page breaks in Print Preview pane, 208
printer properties, 205
ruler, 115-116
text in shape data fields, 278
distributing shapes, 113-114
drag operations, behavior of connectors
during, 132
drawings
cloning, 47
checking out with SharePoint, 318-319
color, applying, 77-78
combining on a single sheet, 263
exporting to image formats, 240-242
headers and footers, adding, 157-159

7/1/13 11:49 AM

FILL TOOL

pages
adding, 62
background pages, creating, 64
renaming, 66
reorganizing, 66
resizing manually, 71
resizing with Auto Size tool, 69
resizing with Size tool, 68
settings, customizing, 63
themes, applying, 76
saving with AutoSave, 51-52
scale of, changing, 71
shapes
frequently used, 84-86
Quick Shapes stencil, 83
selecting, 82
sharing
with email, 228-229
with SkyDrive, 230-232
with social networks, 232
with Visio Viewer, 230
shrinking to fit page, 259-260
themes
categories, 72
color, changing, 74
custom themes, creating, 75
variants, 73
tiled drawings, printing, 256-258
Drawing Scale tab, 71
drawing windows, 33, 53
closing, 53
opening second view of with New
Window, 56
Presentation mode, 57
switching between, 55
task panes, 34
rulers and grids, 34
drop-down arrows, 23
duplicating
drawings, 47
pages, 63
shapes, 168
dynamic glue, 130-131
Dynamic Grid tool
arranging shapes with, 108-109
shapes, aligning, 109
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E
eccentricity handles, 37
editing
Excel charts, 194
groups, 107
stencils, 93-96
text, 176-177
effects, Embellishment
feature, 76
email, sharing drawings with, 228-229
Embellishment feature, 76, 148, 360
enabling
Presentation mode, 57
task panes, 54
Engineering templates, 44
Excel charts
editing, 194
inserting, 194-196
expanding tool groups on ribbon, 25
exporting drawings to image formats, 240-242
external data
linked data, refreshing, 295
linking with shape masters, 295-296
preparing to match shape data fields, 289
shapes, inking, 288-294
external images, importing, 190

F
Favorites stencil, 89
Field dialog box, 298
fields, adding to headers and footers, 211
file formats
image formats, exporting drawings to,
240-242
older Visio formats, creating, 237
PDF, 210, 236
VSDX, 20, 50
XML, creating, 237
XPS, creating, 236
File tab, Backstage area, 31-33
Fill tool, 181
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FIXED LISTS, ADDING TO FORMAT FIELD

fixed lists, adding to Format field, 274
Flip Vertical tool, 114
floor plans
creating, 366-367
dimension lines, 368-369
flowcharts
BPMN, 346
creating, 10-11
cross-functional, 150
contextual ribbon, 344-345
swimlanes, 343
steps, connecting, 124-127
subprocesses, 340
Flowchart templates, 44
Fluent UI (Fluent User Interface), 22
footers, 211-213
adding to drawings, 157-159
fields, adding, 211
Format Painter tool, 175
Format Picture dialog, 190
Format Shape pane, 174, 190
Format Shape task pane, applying color to
drawings, 78
formatting
connectors, 135
multiple objects, 175
shapes
common attributes, 173
less common attributes, 174-175
text, 176-178
formulas, performing calculations on shape
data field, 298
frequently used Quick Shapes, modifying list
of, 86
frequently used shapes, 84
full screen mode, enabling, 57

gridlines, printing, 221
groups, 102
creating, 103-106
editing, 107
resizing, 104
rotating, 104
when to avoid, 107
when to use, 102
guides, displaying, 115-116

H
handles
1D shape handles, 35
2D shape handles, 36
eccentricity handles, 37
vertex handles, 36
headers, 211-213
adding to drawings, 157-159
fields, adding, 211
help information, Visio Help, 305-306
hiding
comments, 324-326
grid, 115-116
ruler, 115-116
High Quality print output, 221-222
Highlighter tool (Ink), 327
Home tab
Change Shape tool, 87-89
color, applying to drawings, 77
Connection Point tool, 141
Distribute tools, 113-114
Orient Shapes tools, 114-115
Position tool, arranging diagrams, 111-112
Home Tab, straightening shapes with Auto
Align tool, 110-111
Hopkins, Chris, 313
hyperlinks, 188

G
General templates, 44
generating reports, 283-285
glue, 129
Goldsmith, John, 313
graphics, importing vector-based, 196
grid, 34, 115-116
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I
images
clip art, 193
external images, importing, 190
resizing, 192
resolution, adjusting, 192
searching for, 193
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MARSHALL, JOHN

SVG formatted images, 196
vector-based graphics, importing, 196
importing
CAD drawings, 197-199
external images, 190
improved touch support, 18
Info tab, 32
unnecessary data, removing from files,
331-334
Ink tools, adding comments to Visio drawings,
326-327
inserting
Excel charts, 194-196
pages in drawings, 62
SVG formatted images, 197
interface
Backstage area, 31-33
context menus, 31
drawing window, 33-34
Quick Access toolbar, 30
ribbon
commands, adding, 25-27
customizing, 24, 27
tool groups, expanding, 25
status bar, 33
tabs
contextual tabs, 23
controls available on, 22
template tabs, 24
internal resources, Viso Help, 305-306
Internet Explorer, Visio Viewer, 230

J-K
johnvisiomvp.wordpress.com, 312
jumping between drawing windows, 55
keyboards, touch keyboards, 251
keyboard shortcuts
displaying, 39-40
ToolTips
revealing, 38
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L
Layer Properties dialog box, 220
layers, 103
creating, 163-165
selecting items to print with, 219-220
when to add, 165
Layout tool, 118-119
legends, inserting in diagrams, 299
less common format attributes, modifying,
174-175
libraries, SharePoint, 316
line jumps (connectors),
136-138
line properties of connectors, modifying,
135-138
lines
curved lines, eccentricity handles, 37
vertex handles, 36
link data, refreshing, 295
linking shapes, 288
with Automatically Link, 293-294
with Data tab, 289-292
with dynamic glue, 130-131
with point-to-point glue, 129-130
with shape masters, 295-296
lists, 148
adding to Format field, 274
locating
commands with Visio Options dialog box, 29
shapes with Search tool, 96-98
logical diagrams, 354-355

M
manual connections, creating with Connector
tool, 127
manually resizing pages, 71
Maps and Floor Plans templates, 44
margins, 211-214
Marshall, John, 312
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MASTERS

masters, 90-91
creating, 94
creating based on grouped shapes, 106
maximizing print quality, 221-222
menus, context menus, 31
Microsoft Visio 2010 Business Process
Diagramming and Validation (Parker), 311
Microsoft XPS Document Writer, 210
minimizing Shapes task pane, 54
mixed orientation drawings, printing, 260
modifying
common format attributes, 173
connectors with control handles, 138-139
containers, 147-150
less common format attributes, 174-175
line properties of connectors, 135-138
Quick Shapes, 84-86
text blocks, 179
title of background pages, 66
monotone printing, 223
More Shapes tab, 87
Mouse mode, switching to Touch mode,
246-247
moving text blocks, 180-182
multiple objects, formatting, 175

N
network diagrams
logical diagrams, 354-355
rack diagrams, 355-357
Network templates, 44
new features in Visio 2013, 17
improved touch support, 18
streamlined layout, 18
VSDX file format, 20
New Window button, opening second view of
drawing window, 56
nonorthogonal angles, 139

O
Office applications, compatibility with, 238-240
office.com, 307-310
the official Visio blog, 307
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older Visio formats, creating, 237
open drawing windows
opening second view of, 56
viewing with Arrange All, 55
opening Print Settings pane, 214
options for stencils, 86-87
Org Chart tab, 24
organization charts, 359
creating, 363-365
creating manually, 361
photos, adding, 359-361
Organization Chart wizard, 363-365
organizing
diagrams with containers, 144-147
shapes
with containers, 103
with groups, 102
with layers, 103
with Layout tool, 118-119
orientation
mixed orientation drawings, printing, 260
of pages, changing, 67
of paper for printing, changing, 206-208
rotating shapes, 114-115
Orient Shapes tools, 114-115
overlapping shapes, troubleshooting with
z-order, 118
overriding aspect ratio, 170

P
page breaks
Avoid Page Breaks tool, 260
displaying in Print Preview, 208
page scale, 259-260
pages
adding to drawings, 62
background pages
creating, 64
printing, 217-219
title, modifying, 66
containers
adding, 144-147
modifying, 147-150
duplicating, 63
orientation, changing, 67
printing, 216
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REDUCING FILE SIZE

renaming, 66
reorganizing, 66
settings, customizing, 63
size of, selecting, 68-69
themes, applying, 76
Page Setup dialog box, 63, 213
Page Size tab, 68
panes
Format Shape, 174
Print Preview, displaying page breaks, 208
Print Settings
background pages, removing, 217
opening, 214
Print Settings, 204-205
Shapes, 82
Size and Position, 170
paper orientation, changing for printing,
206-208
Parker, David, 312
PDF format
creating, 236
printing to, 210
personalized templates, 45
personalizing stencils, 91-93
photos, adding to org charts, 359-361
Picture Tools Format tab, 190
plans, dimension lines, 368-369
point-to-point glue, 129-130
Pointer tool, handles
1D shape handles, 35
2D shape handles, 36
Pointer tool (Ink), 327
Position settings, changing for Data
Graphics, 300
Position tool, arranging diagrams, 111-112
predefined scale, selecting for drawings, 71
preparing external data to match shape data
fields, 289
Presentation mode, 33, 57
printers, displaying properties, 205
printing
background pages, 217-219
color settings, changing, 223
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from Backstage, 204
background printing, 208
collation, 206
paper orientation, changing, 206-208
Print Settings pane, 204-205
gridlines, 221
headers and footers, configuring, 211-213
margins, configuring,
213-214
Microsoft XPS Document Writer, 210
mixed orientation drawings, 260
page breaks, displaying, 208
page scale, 259-260
PDF file format, 210
print area, selecting, 214-216
Print Preview pane, 208
selecting specific pages to print, 216
shapes, 219
tile drawings, 256-258
using layers, 219-220
print jobs, testing, 210
Print Preview pane, 208
print quality, maximizing, 221-222
Print Settings pane, 204-205
background pages, removing, 217
monotone printing, 223
opening, 214
properties
of connectors, 129, 135-138
of printer, displaying, 205
of SmartShapes, viewing, 187

Q
Quick Access toolbar, 22, 30
Quick Shapes stencil, 83
frequently used shapes, modifying, 86
modifying, 84

R
rack diagrams, 355-357
Re-Layout Page drop-down, 118
Recent Drawings list, copying drawings, 47
reducing file size, 332-334
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REFRESHING DATA LINKED FROM EXTERNAL SOURCE

refreshing data linked from external source, 295
removing
background pages from Print Settings
pane, 217
line jumps, 138
unnecessary data from files, 331-334
renaming pages, 66
Reorder Pages dialog box, 67
reorganizing pages, 66
Report Definition Wizard, 279-285
reports
creating, 279-285
subtotals, adding, 285
totals, adding, 285
resize handles, 170
resizing
Auto Resize feature, 338
grouped shapes, 104
images, 192
pages
with Auto Size tool, 69
with Size tool, 68
shapes, 170-171
swimlanes, 343
text, 179
resolution of images, adjusting, 192
resources, office.com website, 307-310
revealing ToolTips, 38
Review tab, adding Track Markup tool, 329-331
ribbon
commands, adding, 25-27
customizing, 24-27
tabs
contextual tabs, 23
controls available on, 22
template tabs, 24
tool groups, expanding, 25
right-click menus, 31
rotate handles, 171
rotating
grouped shapes, 104
shapes, 114-115, 171-172
Roth, Chris, 312
routing styles (connectors), 136
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ruler
displaying, 115-116
drawing window, 34
Ruler and Grid dialog box, 116

S
Save As
saving diagrams, 49
.vsdx format, 50
saving
diagrams
with AutoSave, 51-52
with Save As, 49
shape data fields, 276-278
VSDX format, 50
scale of drawings, changing, 71
Schedule templates, 45
ScreenTips, 155
searching for images, 193
Search tool, locating shapes with, 96-98
selecting
items to print with layers, 219-220
print area, 214-216
shapes, 82
size of pages with Size tool, 68-69
specific pages to print, 216
specific shapes to print, 219
templates, 45
shape data
fields
adding, 270-274
saving, 276-278
text, displaying, 278
lists, adding, 274
types of, 268
viewing, 186
shapes
1D, handles, 35
2D
handles, 36
resizing, 170
aligning on Dynamic Grid, 109
arranging with Dynamic Grid tool, 108-109
attributes, formatting, 173-175
blending, 348
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SPLITTING CONNECTORS, BEHAVIOR OF CONNECTORS DURING

callouts, adding, 151-154
changing with Change Shape tool, 87-89
comments
adding, 323-324
hiding, 324-326
connection points, adding, 140-142
connectors, 124-125
behavior during drag operations, 132
behavior when deleting shapes, 133-134
behavior when splitting connectors,
132-133
control handles, 138-139
creating with AutoConnector, 125-127
creating with Connector tool, 127
dynamic glue, 130-131
formatting, 135
line jumps, 136-138
point-to-point glue, 129-130
properties, 129
routing styles, 136
containers, 103
data fields, 266-274
Decision shapes, 339
distributing, 113-114
duplicating, 168
frequently used, 84-86
groups
adding to stencils, 106
creating, 103-106
editing, 107
resizing, 104
when to avoid, 107
when to use, 102
ink shapes, closing, 328
layers, 103
linking to external data, 288
refreshing linked
data, 295
with Automatically Link, 293-294
with Data tab, 289-292
locating with Search tool, 96-98
masters, creating, 94
multiple shapes, formatting, 175
organizing with Layout tool, 118-119
overlapping, changing z-order of, 118
printing, 219
Quick Shapes stencil, 83
frequently used shapes, 86
modifying, 84
resizing, 170-171
rotating, 114-115, 171-172
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selecting, 82
stencils
available stencils, browsing, 87
customizing, 91-93
editing, 93-96
Favorites stencil, 89
masters, 90-91
options, 86-87
straightening with Auto Align tool, 110-111
text blocks
background, changing, 181-183
modifying, 179
moving, 180-182
themes, changing, 76
ungrouping, 102
Shapes pane, 82
Shapes task pane, 54
minimizing, 54
undocking, 54
SharePoint, 316
co-authoring, 320-322
libraries, 316
versioning, 320
Visio drawings, checking out, 318-319
SharePoint 2013 Workflows, 347
sharing drawings. See also collaboration
with email, 228-229
with SkyDrive, 230-232
with social networks, 232
with Visio Viewer, 230
Size and Position pane, 170-172
Size tool, selecting size of pages, 68-69
SkyDrive, 50, 230-232
SmartShapes, 185
control handles, 187
hyperlinks, 188
properties, viewing, 187
shape data, 186
smart tags, 188
smart tags, 188
social networks, sharing drawings with, 232
Software and Database templates, 45
Space shapes, 367-368
spacing, 109
splitting connectors, behavior of connectors
during, 132-133
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STATUS BAR

status bar, 33
stencils
browsing available stencils, 87
Callout Stencil, 154
customizing, 91-93
editing, 93-96
Favorites stencil, 89
groups, adding, 106
masters, 90-91
creating, 94
creating based on groups, 106
options for, 86-87
Quick Shapes, 83
frequently used, modifying list of, 86
modifying, 84
Timeline, 357-359
steps, connecting in flowcharts, 124-127
straightening shapes with Auto Align tool,
110-111
streamlined layout, 18
Stroke Eraser tool (Ink), 327
subprocesses, 340
subtotals, adding to reports, 285
SVG formatted images, 196
swapping shapes with Change Shape tool, 89
swimlanes, 150, 343
switching
between drawing windows, 55
between Touch mode and Mouse mode,
246-247
between windows, 53

T
tabs, 53
controls available on, 22
Data tab, linking external data to shapes,
289-292
Drawing Scale tab, 71
File tab, Backstage area, 31-33
Home tab
Auto Align tool, 110-111
Change Shape tool, 87-89
color, applying to drawings, 77
Connection Point tool, 141
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Distribute tools, 113-114
Orient Shapes tools, 114-115
Position tool, 111-112
Info tab, 32
More Shapes, 87
Page Size tab, 68
Print Setup, 68
Print Setup tab, 68
task panes, 53
anchoring, 55
enabling/disabling, 54
Format Shape, applying color to
drawings, 78
rulers and grids, 34
Shapes task pane, 54
Template Gallery, 42-45
template tabs, 24
templates, 13-15, 42
Block Diagram with Perspective, 349-350
Business templates, 44
categories of, 42-45
creating, 252, 255
diagrams, creating without, 46
Engineering templates, 44
Flowchart templates, 44
General templates, 44
Maps and Floor Plans templates, 44
Network templates, 44
personalized templates, 45
Schedule templates, 45
selecting, 45
Software and Database templates, 45
stencils, browsing available stencils, 87
Template Gallery, 42
Timeline, 357-359
testing print jobs, 210
text
aligning, 179
displaying in shape data fields, 278
editing, 176-177
formatting, 177-178
resizing, 179
text blocks
background, changing, 181-183
modifying, 179
moving, 180-182
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WEBSITES

Text Block tool, 180
text boxes, 160
Text Edit mode, 177
text fields, 160-162
Text tool, 177
themes
categories, 72
color, changing, 74
custom themes, creating, 75
for shapes, changing, 76
variants, 73
tiled drawings, printing, 256-258
timelines, 357-359
title of background pages, modifying, 66
tool groups, expanding on ribbon, 25
tools
Flip Vertical, 114
Pointer tool, 35
ToolTips, revealing, 38
totals, adding to reports, 285
touch controls, 248-251
touch keyboard, 251
touchscreens
shapes, working with, 248
touch controls, 248-251
Touch mode
switching to Mouse mode, 246-247
Track Markup tool, 329
adding to Review tab, 329-331
troubleshooting overlapping shapes with
z-order, 118
types of shape data, 268

U
uncollated printing, 206
undocking Shapes task pane, 54
ungrouping shapes, 102
unnecessary data, removing from files, 331-334
uses for shape data, 268
Using Visio 2010 (Roth, Que Publishing), 311
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V
validating diagrams, 346
variants of themes, 73
vector-based graphics, importing, 196
versioning (SharePoint), 320
vertex handles, 36
viewing
open drawing windows with Arrange All, 55
shape data, 186
SmartShape properties, 187
View tab
Dynamic Grid tool, arranging shapes with,
108-109
task panes, enabling/disabling, 54
visguy.com, 311
Visio 2010 Step by Step (Helmers, Microsoft
Press), 311
VisioCafe, 313
Visio Help, 305-306
visio.mvps.org, 313
Visio Options dialog box
commands, locating, 29
ribbon, customizing, 25
Visio Professional 2013, 16
Visio Pro for Office 365, 16
Visio Standard 2013, 16
Visio Viewer, 230, 304
visualsignals.typepad.co.uk, 313
VSDX file format, 20, 50

W
web pages, creating from diagrams, 234
websites
bvisual.net, 312
johnvisionmvp.wordpress.com, 312
office.com, 307-310
visguy.com, 311
visiocafe.com, 313
visio.mvps.or, 313
visualsignals.typepad.co.uk, 313
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WINDOWS

windows
drawing windows, 53
closing, 53
opening second view of with New, 56
Presentation mode, 57
switching between, 55
tabs, 53
workflows, SharePoint 2013 Workflows, 347

X-Y-Z
XML file format, creating, 237
XPS file format, creating, 236
zooming in and out with Print Preview, 208
z-order of shapes, changing, 118

WrightBook 1.indb 384

7/1/13 11:49 AM

